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1. Introduction

Open Source Requirements Management Tool (OSRMT) is a highly configurable, free open
source solution for defining and managing Requirements for software development. This is
an easy to install and easy to use solution with capabilities to document all aspects of
software development life cycle (SDLC).

This solution was initially built in 2006. However no further development happened for many
years. In 2019, the redevelopment was initiated by Alan Clifford and a new version (Version
1.6) was released in Feb 2019 at GitHub. This can be accessed through

https://github.com/osrmt/osrmt

1.1 Purpose of this Document:

The purpose of this document is to assist end users to get an understanding of the functionality

of the system and help them to navigate through the application and effectively use it.

1.2 Who can use OSMRT ?
OSMRT can be used by

1. Single user using their work station
2. A group of users independently working, but willing to share a common database

3. A corporation or organization with multiple users including multi location users.

1.3 Installation Options

OSMRT Application can be installed in any of the below scenarios

1. 2 Tier Architecture where the Application connects directly to a Database and has
the following installation options
a. Single user installation where the Database and Application resides in the
same computer
b. Multi user installation where the Database is centralised and Application

resides in computer of every user.

2. 3 Tier Architecture where the Application connects to the Database through the
J2EE server and has the following installation options
a. Multi user installation with multiple servers and a central database.

b. Multi user installation with Central database and web browser clients

Please refer to Installation manual for help with the installing the application.




2. Getting Started

2.1 Start Application

The Open Source Requirements Management Tool (OSRMT) can be started in the
following ways

1. Using Windows Start - Programs > OSRMT -> OSRMTClient

All Programs | 3

g osRMT b | B OSRMT Client
] -
iy Start i M) Jaspersoft

2. Using a Desktop shortcut
3. From the command prompt
The application may be started from the command line as below

C:\Program Files\OSRMT > run.bat

2.2  Application Log On

The Log On screen prompts for a username, password and environment.

[T Log Onto OSRMT Ver.. — a X
Username; ntq
Passwaord: f;...
Environment: |access J
e [Eance]

&y Invalid password
An error message will display if an incorrect username

or password is used. Clicking on the warning message will open a system log




screen where additional technical messages may be displayed.

[ Log Onto OSRMT Version 1.5 — m] X
Username: | DEMO

Password: |sssss

Environment: [sccess |

& Invalid password Cancel

See the Application Log-on Error section in the Appendix for diagnosing any

application log on errors. Click on the error display to view all errors.

2.3 New Project - New Product

Thefirst stepis to create a new project is to create a “New Product” to store all

requirements and other artifacts.

Create a new product from the menu item File &> New Product as below

HOME INSERT DESIGN PAGE

[d - DEMO®@access
:File Edit Tools Admin System View

Mew Product... Ctrl+M
X
P

<3 Open... Ctrl+0

1'322}

Change Password

Exit

The product name that is entered above will be displayed throughout the application and

standard reports.




24 Open Product

The product can be opened from Menu item as below

File Edit Tools Admin System View Help

PaoB il ¥av

D Open a product to start

[ Open Product X

Example
Example 2

OKN | Cancel

OSRMT - DEMO@access
File Edit Teols Admin Systemn  View Help

Bead® 0 & A~ °

Product e ‘

| OSRMT
Elﬁ Feature
(] Ability to define Requirements

----- & Ability to modfy requirement
@ Requirement

@ Ability to modify requirements
-~ @ Define the list of functional requirement

L4 Architecture
[} Database
1 Implementation

-8 Applicationn installation




3. Manaqing Artifacts/ Functionalities

3.1. Artifact Tree

Artifacts can be defined by the administrator. The artifacts that are available
as base line are Features, Requirements, Design Modules,
Implementations and Test Cases

The name of the artifact can be customized by the Administrator. The

default list is shown below. Artifacts can be created under each of these

artifact types.
New Artifact
a. To create a new arteficat, choose New Artifact option under System Menu as
below
[ OSRMT - DEMO@access
File Edit Tools Admin | System View Help
Ra@a m
[ ] Open a product ta start | i |
Export Reference
Debug
Mew Artifact x
MNew Artifact...
MNew Field... Enter a new artifact name
: » Architecturel
il Copy fields and security from X

Requirement
Design
Implementation
TestCase

Artifact

0K Cancel

b. To create an artifact of a specified type, select the artifact and click on the New button

as below.




For example to create a New Feature, Choose New Feature from Menu as below

[ OSRMT - DEMO®@access

File Edit Tools Admin System View
New, Ctrl+N
New Feature

E\k New Requirement

[T New Design

[}k New Implementation

Dﬁ New TestCase

=3 Open... Ctrl+0

Close
29 Refresh F5
Change Password

Import...
Export...

Exit

Enter the relevant data in the screen/form below and save the record to create a child

record under Feature artifact

]

Fie Edt Tools Admin System View Help
Raeanavid

OSRMT

Status _ Version _Descri

q q ISubmitted[ 1.0 [OSRMTis an op

@ Abity o define Requ 2 Abilty to modfy requirement _To be reviewed _Submitted 1.0 Ability to mod

@ Abilty o mody requ o
ent

=@

Feature Dependencies History.

Priority: [Not required

4} Kllj

Full description of the atf = o 7 Close

Delete Artifact

An artifact can be deleted by selecting it in the Artifact Tree and using the

“Delete” option under Edit on the Menu bar.
Alternatively, the delete button on the tool bar can also be used




[ OSRMT - DEMO@access

FiIc-c-Is Admin  Systern Vil

B o I B

[F}-{F

LEETY
CX

@elete Delete >

File Edit Tools Admin Systemn  View Help
Ba?a(@x avi
Q5SRMT " ‘ — :

; ﬂ Feature
Requirement

Design
3l Implementation

OR

Note that only the artifacts selected in the tree will be deleted. On delete the total number

of artifacts to be deleted will be displayed for confirmation of action.

L= @ 8

X AviES

OSEMT

'i_lﬂ Feature
] Ability to define Requirem

1. VWA

.a' Requirernent

' |% Design

J Implementation
' TestCaze

=

Eay

|+

g Ability to modfy requirem

Select an Option x
'0' Delete 1 artifacts found

il [s3 - Cancel-

Deleting an artifact which is a branch will delete all descendant artifacts

under the selected artifact.

Moving Artifacts

The hierarchy of the artifacts can be changed by dragging an artifact from one

parent to another.

Dragging artifacts from one type to a different type will create a dependency on the

target artifact — but it will not move the artifact.
The artifact types cannot be dragged and moved




View Artifact List

Selecting an artifact in the tree will display all child artifacts in a list to the right.

3 0SRMT - DEMO@access

- o
File Edit Tools Admin System View Help
Ra®E 0 v I8
OSRMT —_——_ — R v e d
: _E%E“’E [ 2 bty o oty wicpieniiéast 0 e s veviect[Sibprica) 61 SR AL iy to ey preimiisy defined veqliemisnk 14/201
»

1 Ability to define Requirements  Not required  Submitted 1.0
i@ Ability to madfy requirement

& Ability to define Requirements
=-@ Requirement

@ Ability to modify requirements
@ Define the list of functional requireme]

- Design
; % Architecture
: Database
2@ Implementation
-8 Ver1s
@B Ver 16
=B TestCase
e8] Applicationn installation

OSRMT s 2n open sourcec product for defining and optimizing the requir... 02/14/2018 19:41.24

TIPS

The display sequence and choice of columns can be customized by the Administrator.
To edit an existing artifact select from the list and double click on it.

To sort the list of artifacts, click on the column header, click on a column header

Refresh Tree

The artifact tree can be refreshed by using the menu options File > Refresh or by
clicking on the icon on the toolbar as below.

[ OSRMT - DEMO@access

File Edit Tools Admin System View [ OSRMT - DEMO®access

New Product... Ctri+N File Edit Tools Admin System View Help

Qﬁl%lﬁé&@m
[ New Requirement OSRMT et

E;\k New Design

[ New Feature

: DAr:hitecture

SR Feature

B J i to mody requirement ]
@k Ability to define Requirements
& Requirement

@ Ability to modify requirements
@ Define the list of functional requireme]

m Design

{4 Architecture
[} Database

Implementation

[ New Implementation

[ New TestCase

&3 Open... Cirl+ O

Import... Ver1.5
Ver 1.6
Export...
TestCase
Exit

OR Er Applicationn installation

Refreshing the tree is used for getting the true state of the system. This will refresh the
screen by extracting the relevant data from the data base again.

TIP

Refresh is normally done to reflect additions or changes by other users or in case of any
errors




3.2 Artifact Data Entry

Each artifact type (feature, requirement, design etc.) will have a different data entry form as
configured by the Administrator.
See below an example of it.

il
File Edit Tools Admin System View Help

a0 ¥~ 8

OSRMT 8] Design Architecture
u Architecture
- Festure Design Dependencies History
@ Ability to modfy requirement
@ Ability to define Requirements
Requirement % = e -
Desigr: (PR Tainaat Priority: |High -
& Ability to modify requirements 2 ¥ |Hig —J
@ Define the list of functional requireme Status: |Unassigned :J Category: LJ
Design 4
Version: 1.0 -
SN Architecture —J
Database e
=@ Implementation Attachments: PERRES R ER NeTE DRHES
erls
Ver 1.6
T StCE’ The overall architecture diagram is attached.
2 i . Broadly , there are 2 provisions
L Applicationn installation 1. 2 Tier architecture where in the application directly connects to the DB
2. 3 Tier architecture where in the application connects to the DB through JBoss
Description:
i Design medule name P MG pY e

Custom Forms

The Administrator may add or remove tabs and controls or lock controls from editing. Controls
may have default values or a custom list of values from the Reference table. The Administrator

may write a custom Javascript to format or initialize a control.

Custom controls may be created to store new data in the database.

Attaching or Linking Documents

Right click in the attachment list to popup a menu of additional options.




FileMame SoUrceE

Aktachments:
kest,doc
Insert File
Description: | shall be able to define a cu Insert Hyperlink zakure, t
Delete
Properties

Selecting the menu item “Insert” will prompt to select a local or network file. Select and
press “Open” to upload the file to the server or local storage where a copy is placed in a
storage area defined by the Administrator.

Once a file is in the list, the FileName display or Source description may be changed using
the menu item Properties.

Hyperlinks may be stored using the menu item Insert Hyperlink.

Modification History

The full history of creation and modification is available including the time and date before

each update. See Sample below

[ Feature Ability to modfy requirement X

Feature Dependencies History

Created By: | Administrator, Demo | Created: |02/14/2019 19:58.17

Last Update By: | Administrator, Demo ;] Updated: |02/14/2019 19:59.02

e

ity to modfy requirement Submitted

eviewed (02/14/201919:5002 Administrator, Demo

Modification History:

i Date this record was created 3
< Back Next > Apply Cancel




4. Traceability

4.1 Traceability
Child Artifacts are not dependent

Selecting an existing artifact and creating a child artifact will automatically create a relationship

between the two artifacts. This however does not create a dependency.

Adding dependencies

The dependencies define the traceability between the artifacts. To trace additional artifacts to
an opened form, right click in the related artifact list and select the menu New.... Select all

artifacts to be dependent on.

iE Requirement @

Requirement | Detalls | Backgraund | Lise Case ' Dependencies '\ History i

-1 System Output

E-E5 Security

o Position Management
D User management
B[ Customization

(& Requirement.

B[] Data Requirements
(i Use Cases

[ Manage AritiFacts

: Marage: Users
] ExportiImport

[ Locate Artfacts

{7 Traceability

D Manage Reference

3 D Manage Forms

D Manage Baselines
B[ Performance Requirements
-1 Design

(23 Implementation

3 Testcase

Dependent on:

i Right click on the list to addfremove (selected) relationships for traceability  ————— — -
OF || Cancel

4.2 Traceability Tree

The traceability tree can be viewed using the menu option View traceability from the menu

bar as below

| B8 osRMT - DEN

| File Edit Tools Admin System View Help

T L a @5 3 ¢ [T Traceability matrix OSRMT - DEMO@zccess - o X
OSRMT File Edit

w[ ] Architecture i o M-

e EE12&E
@ Ability to define Requirements OSRMT OSRMT

g it to mody requirement]
1@ Requirement

@ Ability to modify requirements

|-@ Define the list of functional requiren

&4} Design
-y Architecture
-} Database

=@ Implementation

pplicationn installation
User Creation

i@ F1: Ability to define Requirements
L@@ F2: Ability to modfy requirement

i Architecture
- Feature
@ Requirement

L-J A\bility to modify requirements|

@ Define the list of functional requirement
40 Design

mplementation

/8 TestCase

The requirement is to be able to modify already defined requirement




Pressing the Trace “left to right” buttonwill create a dependency from the artifact on the top

to the artifacts just below it. You can also trace from the menu Edit > Trace left to

right.

Pressing the Trace right to left button will create a dependency in the opposite direction.

See below.
i/ Traceability matrix OSRMT - DEMO@access =
File | Edit
E Trace left to right  Shift+F2
_; Trace right to left  Shift+F2
04 QSRMT
@ Untrace D Architecture
- - Feature
Cnlena, Requirement
Sl Ability to modify requirements
| -@ Define thelist of functional requirement
5 Implementation
TestCase
| B Tracesbility matrix DSRMT - DEMO®@ac
| File Edit
it d M-
i .
QSRMT OSRMT

i@ F1: Ability to define Requirements

2 Ability to modfy requirement

e D Architecture
A Feature

1@ Requirement

L= Ability to modify requirements

@ Define the list of functional requirement

£ m Design

(#-[@ Implementation

Trace X

‘.Q' Create dependency from Ability to modify requirements on Ability to modfy requirernent

Cancel

The requirement is to be able to modify already defined requirement

TIP

Only one artifact should be selected on one of the sides — otherwise a confusing number of
dependencies will be created.

It is possible to create a dependency for a single feature on multiple artifacts.

Traceability Tree Options

The display on the right pane is the full artifact tree. The display on the left is a
dependency or traceability tree. To change the display of the traceability tree use

menu Edit = Criteria or press the Criteria toolbar button.




" Qe

File Edit

B a2 =

OSRMT [H Trace tree criteria x
- @ F1: Ability to definef .
@ :

Trace: |No restrictions ;I Artifact: |Feature _'_]
1[ Allow tree cycles: [~

Max tree depth: |5

Architecture
Feature
Requirement
Design

Traceto: Implementation
TestCase

[ ok [ Coneel

4.3 Traceability Views

“Traced” and ‘untraced” views are available in the system. To get to these views,

Use Tools = Trace Options from the menu bar.

[T OSRMT - DEMO@access
File Edit Tools Admin System View Help

Ba2i8d dsvIill
OSRMT
~[] Architecture
L O.Feature y re emel ed requirement
@ Ability to define Requirements
B B/ bility to modfy requirement
@ Requirement
@ Ability to modify requirements
{EO Define the list of functional requiremel ,‘_l
I Design
g % Architecture Trace To. | Apply | R
~ Database
Implementation P& Change Impact
Ver13
Ver15

Trace From |Requirement Trace Type |Traceability Matrix

pplicationn installation
Ol User Creation Ability te modify requirements
Define the list of functional requirement

i Constrain the types of artifacts the tree traces to

Close

Ability to




»C;rtlF'act Descripkion
Custorn numbering system
Export artifacts

Manual artifact entry
Custom artifact attributes
Hierarchy of artifacts
Status report

Attach or insert external links
Artifact Traceability
Artifact Definition

Artifact Analysis

Trace Fram: |Festure ‘V|
Trace To: |Requirement ‘v| |

Trace Type: |Mot Traced - ‘

fiply |

RIERENC i =
Shall be able to enter the Full artifact text description. | a
Shall allow administratar to determing the method For
Export artifacts from praduct or project ta project.
Shall be able to enter artifacts (Feature, requirement ¢
Shall be able to define a custom field for each artifact
Shall be able to organize artifacts inko a hierarchy,
Shall generate a status report filkered by category an
Shall be able ko attach or link external documents.,

[T

‘ Close

4.4 Trace Impact

To trace the impact, select an artifact from the tree and use menu items Tools - Trace

Impact. A graph of the artifacts dependent on or from the selected artifactis shown.

dinge [

Feature One

y

Requirement Cne | |

Feature bwo

| Close




5.1 Standard Reports

5. Reports

Reports canbe accessed fromthe menuitem Tools - Reports option as below

[ oSRMT - DEMO®access

File Edit | Tools Admin System  View He

Reports... Ctri+-R
Trace impact...

Trace..,

Filter...

—

a3

% Architecture

{4 Database
Implernentation
L (B Ver1 5

To create a report for a single product, select that product. Otherwise make no selection as

below.

Then choose HTML or PDF option to generate the report

[ Add report

lep )
All Artifact Details
Artifact Detail
Artifact Summary

Cancel < Back

. br_opeﬂ.:ies,..

MNext »

Finish

[T Generate Report: All Artifact Details

Example2
Medico

Products: OSRMT

< Back

HTML

PDE..

TIP

Report may fail with some operating system. In that case start the local browser or pdf

viewer and then open the generated report file.

Files are typically created in <client directory>\temp\<filename>




5.2 Custom Reports

*Backup any reports you do not wish to lose*

Copy report

Navigate to the reports directory e.g. C:\Program Files\osrmt\v1_6\client\reports.
Copy an existing source file report to a new name

Example: “copy ArtifactDetail.jrxml newreport.jrxml”

Open the report writer via shortcut or from report writer bin directory. Example below

“C:\Program Files\osrmt\v1_6\client\reportwriter\JasperSoft\iReport-
1.2.2\bin\startup.bat”

Loskins |3 repnts ¥ FEE

3 | rtfoct_scmmery. oo
) |t sctDiekad, o

Myecent |2 newreport raml

Eocuments. i )

L:I)

Dieshtop

2

Hy Cocuments.

|
My Computes
My hestweowk

Mace s of bype: JasperReports XML *. o, ol -

Pl riamay; ressreport. jroml

i

Add report to OSRMT
Within OSRMT use Menu - Tool = Reports and press the Add Report button.

Complete the form ensuring the file name in the reports directory matches the file name
listed (without any directory prefix).

&=

BB Add report
Custom report.

Repork name: e Report
Flename: |nevrepcrt. jasper

select * from artfactdetail

Active: [

Ok |[ Concdl

TIP

[ Please get assistance from a system administrator or developer if you are developing a J

report with complex SQL as it may have impact across forms




6. Import/Export

6.1 Exporting artifacts

For exporting artifacts, Navigate to selected branch of the requirements tree. Then filter the

list and/or search for artifacts to create a custom list of artifacts.

File > Export options from Menu bar can also be used for exporting the artifacts from the
filtered list.

BE Export Artifacts (XML)

|Brtifacts|’,

Export ko | | |:|

Remove primary key (add when imported) [

OF | [ Cancel

TIP

Select the option -“Remove the primary” key” to import into a new database.

6.2 Importing Artifacts

Navigating to a branch in the requirements tree will enable the option to
import artifacts under a specific branch in the tree.

BB import Artifacts (XML)

|Artifacts |

Import File | | I:‘

Import under selected artifack [ System Data Entry

Preview H Ok || Cancel

TIP

Ensure the artifacts that are added have the artifactld = 0 and artifactNbr =0 .
The import file should be of the same XML format as the file exported




7. User Management

7.1 User Creation

To add a new user choose Admin - Users option from menu bar as below

! -
[ Create New User
General Technical

Hraton, Last Name: First Name: |

ADMIN Arunan |suchita
Manager, Marketing MARKETING Marketing Username: | Suchita UserID: g
Anton, Tim Anton Developer e : :
Alan, Clifford Alan ADMIN Position: | [sldiid _'_1 Active: v
Coder, Develop CODER Developer X .

Change password...
Add Row
Cancel < Back Mext = Finish
OK Cancel

7.2 Adding / Removing user from user groups

To add or remove a user from/To a group, ch

Admin > User Groups option from menu bar as

oose

below

The below screens show how to add a user or remove a user from a group

[T select user group

1383 Administrator ADMIMISTRATOR UserGroup D

1378 Business analyst BUSINESSAMALYST  UserGroup D

13?9 Change Control Board CCB UserGroup
__-

1384 Documenters DOCUMENTORS UserGroup

1380 Product Manager

PRODUCTMANAGER  UserGroup
1385 Quality Regulator

D
CQUALITYREGULATOR  UserGroup ]
1382 Quality testers CQUALITYTESTER UserGroup 0
21 X
Cancel < Back

Finish




[ Add new user group

User group: |Developer :j

i Userto add to group

User: | :J

Administrator, Demo
Marketing, Demao
Anton, Tim

Alan, Clifford

Coder, Develop =

(]

Add Row Remove Row

Cancel < Back Mext >

T T T e T R T I R I

Finish

Arunan, Suchita




9. Definitions

Below are the list of key words used in this project and their definitions.

Field

Description

Trace

Allows auditing on the artifact list.

‘Child dependencies’ restricts artifacts in the list to those with

an existing trace(dependency) to a child artifact

‘No Child dependencies’ shows all artifacts without a trace to a
child artifact ‘Parent dependencies’ restricts artifacts in the list to

those which have another artifact tracing to it.

‘No Parent dependencies’ shows all without a trace to a child artifact.

Direction

Trace down to will show dependencies on child artifacts.

Trace up to will show artifacts which trace to the top level artifacts. The
fact that the ‘parent’ artifacts will be shown as a child in the tree may be
counter intuitive. Note if you just created a dependency — but not in this
direction the tree will not change.

Allow tree cycles

With this off no artifact added to the tree will display twice. This may
create a misleading picture.

Max tree depth

Prevents circular dependencies from going too deep.

Trace to

The type of artifacts to trace down or up to in the tree.

Artifact

An artifact is the specification of a physical piece of information that is
used or produced by a software development process, or by deployment

and operation of a system







